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I r«if Print

This printer supports Exif 2.2 (also called “Exif Print”).

Exif Print is a standard for enhancing the communication between digital cameras and printers. By
connecting to an Exif Print-compliant digital camera, the camera’s image data at the time of shooting is
used and optimized, yielding extremely high quality prints.

I C:nadian Radio Interference Regulations
This digital apparatus does not exceed the Class B limits for radio noise emissions from a digital
apparatus as set out in the interference-causing equipment standard entitled “Digital Apparatus,”
ICES-003 of the Industry Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils
numériques de Classe B prescrites dans la norme sur le matériel brouilleur NMB-003 d'Industrie
Canada intitulée « Appareils numériques ».

I 11 ¢crnational ENERGY STAR® Program
As an ENERGY STAR® Partner, Canon Inc. has determined that this product meets the ENERGY
STAR guidelines for efficiency.

The International ENERGY STAR® Office Equipment Program is a global program
/\ that promotes energy saving through the use of computer and other office equipment.
W The program backs the development and dissemination of products with functions
— that effectively reduce energy consumption. It is an open system in which business
can participate voluntarily. The targeted products are office equipment such as com-
puters, monitors, printers, faxes and copiers.

Their standards and logos are uniform among participating nations.

I rover Requirements

Never use a power supply voltage other than that supplied in the country of purchase. Using the incor-
rect voltage could cause a fire or electric shock. The correct power supply voltages and frequencies are
as follows:

AC 100-127 V, 50/60 Hz
AC 220-240 V, 50/60 Hz

Printer Model: K10223 (i470D)



Preface

Shipping Materials

Thank you for purchasing a Canon Bubble Jet Printer.
Check that all the following items are in the box. If anything is missing or is damaged, contact your Canon
Authorized Dealer or Sales Representative.

U Printer
U Setup Software & User’s Guide CD-ROM
U Quick Start Guide

d Print Head
U 2 Ink Tanks

* A USB cable should be purchased separately according to your computer. For details on cable
specifications, refer to page 3.

Introduction

This Quick Start Guide uses the following symbols to indicate important information. Always observe the
instructions indicated by these symbols.

Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Also read the Safety Precautions in the User’s Guide. Observe the warnings and cautions to avoid
personal injury or damage to the printer.

/Trademark Notices

+ Canon® is a registered trademark of Canon Inc.

+ BJ™ is a trademark of Canon Inc.

+ Microsoft® and Windows® are registered trademarks of Microsoft Corporation in the U.S. and other
countries.

* Apple, Mac, Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other
countries.

* CompactFlash is a trademark of SanDisk Corporation.

* MEMORY STICK is a trademark of Sony Corporation.

* SmartMedia™ is a trademark of Toshiba Corporation.

* Microdrive is a trademark of International Business Machines Corporation.

* All other trademarks and registered trademarks appearing in this Quick Start Guide are the property of
their respective owners.

Copyright ©2003 CANON INC.
All rights reserved. No part of this publication may be transmitted or copied in any form whatsoever
\without the express written permission.




Setting Up

1 Preparing the Printer

Place the printer on a flat surface.

Remove the tape from the printer as
shown.

The tape position is subject to change.

Attach the paper rest to the sheet
feeder.

Pull out the output tray.



2 Connecting the Printer to the Computer
Use a USB cable.

Recommended: Canon or other computer manufacturer cable, up to 5 meters in length.

= Notes

« If your computer has an earth connection, make sure that this is attached.
* If you do not intend to use the printer for a long period of time, unplug the power cord from the
power outlet after turning off the printer.

Follow the steps below to install the printer driver
correctly.

1 Ensure the printer and the computer are
switched off.

2 Connect the cable.

= Note

If the Add New Hardware Wizard or Found New Hardware Wizard
screen appears when carrying out the following operations, click
Cancel and turn off the computer.

‘Welcome to the Found New
Hardware Wizard

Tris wizad helps you instl sotware or

with an installation CD




3 Installing the Print Head

* Never attempt to plug the power cord into the power outlet or unplug the power cord when your
hands are wet.

* Never damage, modify, stretch, or excessively bend or twist the power cord. Do not place heavy
objects on the power cord.

* Never use any power supply other than the standard power supply available in the country of
purchase. Using the incorrect voltage and frequency could cause a fire or electric shock.

 Always push the plug all the way into the power outlet.

B Installing the Print Head
1 Plug the printer in.

Turn on the printer. Do NOT turn on the
computer yet.

The POWER lamp flashes and the printer begins to
operate. Wait until the POWER lamp remains fully lit.

3 Open the output tray.

4 Open the front cover.

The print head holder moves to the center.

print head holder



lock lever 5 Raise the lock lever.

Do not touch internal parts other than the lock lever.

6 Remove the protective cap from the

print head.
= Notes print head electrical
« Do not touch the print ~ nozzles contacts

head nozzles or
electrical contacts.

* Do not attempt to
reattach the protective
cap once it has been
removed.

7 Place the print head in the holder.

8 Lock the print head into place by
lowering the lever.

Do not touch the lock lever once the print head has been
installed.




B Installing the Ink Tanks

* For safety reasons, store ink tanks out of the reach of small children.
* Do not drop or shake ink tanks as this may cause the ink to leak out and stain your clothes and hands.

1 Take out the black ink tank.

Hold the ink tank as shown in the
diagram and remove the protective cap.

protective cap

= Notes ink port

* Do not touch the ink port.

* Do not attempt to reattach the
protective cap once it has
been removed.

3 Insert the black ink tank into the right-
hand slot.

4 Press the tab until it clicks into place.

5 Use the same procedure to install the
color ink tank in the left hand slot.

6 Close the front cover.

Wait until the POWER lamp remains fully lit (about 60
seconds).




4 Loading Paper

B Loading A4 (Letter) Size Plain Paper
paper thickness lever 1 Open the front cover.

Move the paper thickness lever at the
top of the print head holder to the left
position. Close the front cover.

= Note

Set the paper thickness lever to the left when using
plain paper, to the right when using thick paper.
Refer to the User’s Guide for information on loading
envelopes and other media.

Pull out the paper rest and the output
tray as shown.

To avoid paper jams, fan the stack to
remove static cling, then align the edges
of the stack by tapping it on a flat
surface.

Load the paper, aligning it with the right
side of the sheet feeder.

You can load up to 100 sheets of plain paper. Do not
exceed this limit.

Press the paper guide and slide it
against the left side of the stack of
paper.

You now need to install the printer driver:

Windows: Go to page 8
Mac OS 8.6-9.x:  Go to page 11
Mac OS X: Go to page 13




5 Installing the Printer Driver

= Notes

If you are printing with only Direct Print, skip this chapter and go to “Aligning the Print Head” on
page 16.

B Installing the Printer Driver — Windows

= Notes

Do not disconnect the cable or remove the CD-ROM during the installation. The driver cannot be
correctly installed.

The screens below refer to Windows XP installation. Screen may differ depending on the operating
system you are using.

When installing the printer driver in Windows XP or Windows 2000, log on to the system as a
member of the Administrators group.

The Setup Software & User’s Guide CD-ROM contains the application software. If you want to
install the application software, click Install on step 7. Internet Explorer 4.0 or later must be
installed for Easy-PhotoPrint.

If the following screen appears automatically, click Cancel and follow steps 1 to 8 to install the printer
driver.

‘Welcome to the Found New
Hardware Wizard

wizard helps you nstalsoftware for:

@ Cick Firih to 0o to Help and Support Center fo futher
help nstaling this hardwate.

il this softuiare.

Dorit pomet

Special Notes for Windows 98 or Windows Me USB Users

Click Cancel to quit the screen and turn off the printer. Next, remove and replace the USB cable
connected to your computer.

1 Ensure the printer and computer are
switched off.

2 Turn on the computer and start
Windows. If any applications
automatically run, quit them.

Disable any virus detection programs.
Do NOT turn the printer on at this stage.




canon | engi About

Ve diver i talled the sy,

[V s e s _ Reatme
Printer Driver [ Photo Viewer 1M __ Readme
Other Driver

Application

Documentation. f |
W l Install ” =)

Printer port
lo s conn

3 Place the Setup Software & User’s

Guide CD-ROM in the CD-ROM drive.

= Notes

* If the CD-ROM does not run automatically, click
Start and select My Computer, then double-click
the CD-ROM icon. For non-XP Windows, double-
click My Computer in the Windows screen, then
double-click the CD-ROM icon.

« If the language selection screen appears, select a
language, then click the Next button.

Follow the instructions displayed on
screen. When the screen shown on the
left is displayed, click Install.

When the screen shown on the left
appears, turn the printer on.

If the printer is recognized, the printer driver will be
automatically installed.

= Note

If the connection is not recognized, refer to the
section “Notes on Handling the USB Interface (for
Windows Users)” on page 27.




Terminate Installation 6 C I | Ck 0 K .

Software installation is completed.

Before you use the printer, you must carry out print head
alignment on page 16.

Istallation results are as fallows.

Printer Driver Instalied
Photo Viewer Installed
o R 7 Click Install to install the memory card
utility.
[ emary Cort ity T _ Readme
Printer Driver
Other Driver
Application |
Documentation i
@ ' Install i' =)
Terminate Installation 8 CI|Ck OK
Software installation is completed.
Installation results are as follovs.
Memory Card Utility Installed
L e 9 If you want to install the application
| software, click Install.
[ Easy-PhotoPint M _ Readme
PriniceDrives |1 [ Ervarin - G Follow the instructions on screen to install the
e | application software. When the message “Software
- | installation is completed.” appears, click OK.
(—Jl 10 Click Exit.
@ | Install
= Notes

* To view the User’s Guide, please refer to “How to View the User’s Guide” on page 27.

+ If a message prompting you to restart the computer appears, click Yes.

* For further information of applications and how to start them, refer to “Applications Included in the
CD-ROM Package” on page 28.
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B Installing the Printer Driver — Macintosh

= Notes

* Do not remove or insert the USB cable during installation, as this may result in the computer or
printer not operating normally.

* Before installing the driver, disable all virus detection programs and automatically loading
programs or remove them from your system folder.

* The Setup Software & User’s Guide CD-ROM contains the application software, Easy-PhotoPrint,
to import and print image data. If you want to install Easy-PhotoPrint, double-click the application
folder, then double-click the Easy-PhotoPrint folder and then Installer. Refer to the Photo
Application Guide in your CD-ROM.

For Mac OS 8.6-9.x Users
1 Turn on the Mac.

2 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

Ll T —— 3 Double-click the Mac OS 8.6-9.x folder.
I<\>Z
e U e 4 Double-click the Printer Driver folder,
' then select a language.

[«

m
L

O ——=0 tuish = Double-click Installer.

5] 3 items, 3.9 MB available

@
E=2|
I nstaller Read Me

BED

[{]¥

6 Read the License Agreement and click
Accept to continue.

11



Easy Install E

Click “Install" to install the following software: After the installation is
completed, restart the computer.

+1470D Qu w printer driver

+1470D pri tilities

+1470D pri rofile

Install

Z

Installation was successful. You have installed
software which requires you to restart your
computer. Ifyou are finished, click Restart, or ifyou
wish to perform additional installations, click

Continue.
] () Mac 05 8.6-9x
a 3 items, 3.9 MB available
Printer Griver Application HMemory Card Utility/ | = |
[+ ]Z
O (3§ Memory Card Utility
a & items, 3.9 MB available

B Uninstaller

English French German -
Spanish [=]
KDz
Installer B

Welcome m

Welcoms to the B Utility I nstaller

This pragram installs the BJ Utility an the Macintosh, Click the right
arraweta close all applications and proceed with installstion

Installer

Software License Agreement

Please read the following licenss agrasment carsfully.

CANON SOFTW ARE LICENSE AGREEMENT

IMPORT ANT-READ THIS AGREEMENT BEFORE INSTALLING THE PRINTER CRIVER
IFOR BUBELE-ET PRINTER. B INSTALLING THE PRINTER DRIVER FOR
[BUBBLE-ET PRINTER, L1 ARE DEEMED TO AGREE T0 BE BOUND BY THIS
|AGREEMENT.

This legal dosument is 2 licenss agresment betwsen you and Canan
inc ¢ “Canon”

B INSTALLING THE FRINTER: DRIVER FOR EUEBLE-JET FRINTER (THE
["SOFT ARE"), YOU ARE DEEMED TO) AGREE T0 BE BOUND BY THE TERMS OF

Do youagree withall the terms ofthe license agreement?

() Dpisagree @ Agree

Bl@
)
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7 Click Install.

Wait for the installation to finish.

= Note

No other applications can be running during

@ this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

([Comtme

If the above message appears, check that there are
no unsaved documents, then click the Continue
button. If a document needs to be saved, click
Cancel then save the document. After saving the
document, begin again from step 4.

Click Restart.

The computer restarts.

Double click the Memory Card Utility
folder of the Mac OS 8.6-9.x folder.

10 Double click the BJ Installer.

11 Click [2].

12 Read the Software License Agreement

and if you agree, click Agree and then

click [2].



Installer —————g|

Selection of the HD to install

Installing the BJ Utility,
Selectthe HD an which ko install,

HO:  (Macintos UK =

Aftarsslacting the HD to install, click Install,

The background application and USBstorage driverare installed inthe
function Extensions folder,

(W)
)

L0 File Edit View Window Special Help

About This Computer

&0 Apple System Profiler
& B Utility

= Chooser

=&

(i, Favorites
Key Caps
= T

= chooser.

Connected to @
o e

e

® Active
Q Inactive

oo
il

AppleTalk

7.6.2

8006 % CANON_B/ =

Mac 05 8.6-9.x Mac 05 X Manual

13 Click Install.

Installation is started, and when completed, a message
for successful installation will be displayed.

Click Restart now.

14 Select Chooser in the Apple Menu.

15 Click the icon for the printer you are
using and close Chooser.

Before you use the printer, you must carry out print head
alignment on page 18.

= Note

Refer to the User’s Guide when using this printer as
a network printer.

For Mac OS X Users
1 Turn on the Mac.

2 Place the Setup Software & User’s
Guide CD-ROM in the CD-ROM drive.

3 Double-click the Mac OS X folder, then

double-click the Printer Driver folder.

13



800 Install B) printer driver

Software License Agreement

English =
‘CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT-READ THS AGREEMENT BEFORE INSTALLING THE

PRINTER DRIVER FOR BUBBLE-JET PRINTER. BY INSTALLING THE.
PRINTER DRIVER FOR BUBBLE-JET PRINTER, YOU ARE DEEMED TO
AGREE TO BE BOUND BY THIS AGREENENT.

(THE "SOFTWARE"), YOU ARE DEEMED TO AGREE TO BE BOUND
BY THE TERMS OF THIS AGREEMENT. F YOU DO NOT AGREE TO
THE TERMS OF THIS AGREEVENT, DO NOT INSTALL THE
'SOFTWARE AND PROMPTLY RETURN THE CANON DISK TO THE
PLACE WHERE YOU OBTAINED IT FOR A REFUND BEFORE THEY

) Cowr)  Covmi) o)

Installing this software requires 12.5M8 of disk space.

You have selected to instal this software on the disk "Work_UK."

800 Install & printer driver

Easy Install

Click Install to perf
sof

tems, avallable
Printer Driver Application \ Memory Card Utlty

14

Double-click i470D.mpkg.

Enter an administrator name and a
password, then click OK.

Click Continue.

Read the License Agreement and click
Continue, then click Agree.

Select a destination to where you want
to install the printer driver, and click
Continue.

9 Click Install.

10 A message asking for your confirmation

to restart your computer appears on the
screen. Read the message, then click
Continue Installation.

Software installation will start.

11 Software installation is complete.

Restart your computer.

12 Double click the Memory Card Utility

folder of the Mac OS X folder.



800 T3 Memory Card Uity =
X 5 tems, 5.9 M8 avalable
P _ _
o =] 7]
Deutsch English Espanol
a -
7] 7] =
Frangais aliano Nederland:
Y
nstall & Utility

_ Software License Agreement

English ]

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT-READ THIS AGREEMENT BEFORE INSTALLING THE
PRINTER DRIVER FOR BUBBLE-JET PRNTER. BY INSTALLING THE
PRINTER DRIVER FOR BUBBLE-JET PRNTER, YOU ARE DEEMED.

TO AGREE TO BE BOUND BY THS AGREEMENT.

Tielegefomrmontiv s nsmee apsemas bewma s
mmmmmmmmm
o NSTALUNG THE PRINTER DRIVER FOR BUBBLE-JET PRINTER
(THE RS SRS T ST R SO
S THE TG OF THS AGREEVENT. 10U DG NOY AGREETO
THETES OF THS AGEEMENT, 0O NOT INSTALL THE
'SOFTWARE AND PR CANON DISK TO THE.
PEACE WHERE Y00 OSTAIED T FOR  REFUND BEFORE THEY

Cre) Cswe) ((M,)

Instal &) Utility

Gisk to install the B] Utiity software.

@gg

0608 670a 100 0.0 B3GR ey 5:668 018 =
$L]

stalling ths software requires O bytes of disk space.

You have selected to install this software on the disk “Work UK.

Install &) Usility

Easy Install

Click Install to perform a bas
softwar

Con)(Cma))

Instal &) Utility

Install Software

The software was successfully installed

Click Restart to finish installing the software.

Cone> @D

13 Double click BJUtility.mpkg.

14 Enter an administrator name and a
password, then click OK.

15 Click Continue.

16 Read the License Agreement and click
Continue, then click Agree.

17 Select a destination to where you want
to install the memory card utility, and
click Continue.

18 Click Install.

19 A message asking for your confirmation
to restart your computer appears on the
screen. Read the message, then click
Continue Installation.

Software installation will start.

20 Software installation is complete.
Restart your computer.

Before you use the printer, you must carry out print head
alignment. For instructions on how to align the print
head, refer to the Printer Driver Guide for Mac OS X. To
view the Printer Driver Guide for Mac OS X, double-
click the Manual folder and Additional Guide for OSX
User’s folder and select the language folder that you use
as necessary.

You can also refer to the Printer Driver Guide for Mac
OS X for instructions on how to use the printer driver.

15



6 Aligning the Print Head

This operation must be carried out when using the printer for the first time. Aligning the print head positions
allows you to print without shifts in the color registration.

B Aligning the Print Head — Windows

1 Click Start and select Control Panel,
Printers and Other Hardware, and
then Printers and Faxes.

= Note

For non-XP Windows, click Start, then select
Settings, Printers.

2 Click the icon for your printer.

% Printers and Faxes 3 Open the File menu and select:
Edt View Favortes Took Help
open D ot [y rotes | - * Windows XP/Windows 2000 —
AL G —— — [Printing Preferences...]
e e N - » Windows Me/Windows 98 — [Properties]
Sharing. .
Use Printer OFfline .
DS~ | to open the setting screen.
Server Froperties
Set Up Faxing
Create Shortcut
Delete
Rename
Properties
Close
Canon 470D, E\ 4 Click OK
A This printer requires print head slignment.,
Click Print Head Alignment on the Maintenance tab to start lignment,

5 Click the Maintenance tab, and click
Print Head Alignment.

©

16



Print Head Alignment @@

Print head alignment is bsing sxecuted Refering to the pattems
printed in calumns A to K, select the pattem that shows no flaws

Horizontal Alignment (340 +
Colunn &
Colunn B: =
Colurin C: =
Colurin D: o=
Column E; =

Bi-diectional Alignment [5 to +5)

Coluran £ o=
Colurin G; [p =
Ballurrnld] =
Column | [ =
Column J: [p =
Colurin K: [f =

0K Cancel ‘ Help

Print Head Alignment @@

Print head alignment is bsing sxecuted Refering to the pattems
printed in calumns A to K, select the pattem that shows no flaws

Harizontal Alignment (3 to +7)

H Colurin &: =
E cobmn: ([0 =)
B Colurin C: =
- Colurin D: o=
Column E; =

Bidiectional Alignmert 5 to +5)

Column £

Column J

Column K

Cancel Help

Canon, 470D,

X L@ﬂﬂﬂm

-
\‘IJ Print head alignment is now complete,

6 Check that paper is loaded in the printer

and click OK. If a message warning you
not to perform other operations
appears, click OK.

It takes about 60 seconds to start printing.
After the pattern is printed, click Yes.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.

In the same way, one by one, select the
most even patterns printed with the
least irregularities from each of
Columns B to K, enter their numbers,
and click OK.

If it is difficult to pick the best pattern on Column H,
pick the setting that produces the least noticeable vertical
white stripes.

Less noticeable
white stripes

More noticeable
white stripes

10 Click OK.

This completes the printer setup. The printer is now
ready to use.

17



B Aligning the Print Head — Macintosh

= Note
For Mac OS X users, refer to the Printer Driver Guide for Mac OS X for instructions on how to
align the print head.

Select Page Setup in the File Menu.

Canon 470D Printer Utility Version 4.3

Nozzle Check
Prints a nozzle-check pattern.

Print Head Alignment
Itwill align the print heads to correct any
error in their installation position.

Print head alignment is being executed.
Alignment entails printing, so do the
following: Ready the printer (connect the
cable and turn the power on),and load a
sheetof plain paper in the sheet feeder.
and load a sheet of plain paper in the sheet
feeder.

Do you want to print head alignment
patterns?

]

Print Head Alignment

Print head alignment is being executed. Referring to the
patterns printed in columns A to K, select the pattern that
shows no flaws.

Adjust e l)

= ColumnA:
E commn: o |3
= Column C:
E commnp: [0 [§]

commne: [0 [g

Column F:
Column 6:
Column H:

Column I

Column J:

ColumnK:

18

Click Utilities.

Select Test Print from the menu and
click Print Head Alignment.

Check that paper is loaded in the printer
and click OK.

It takes about 60 seconds to start printing.

If the pattern is not printed successfully, open the front
cover and ensure that the ink tanks are correctly
installed.

Look at the print-out. From the patterns
in Column A, select the most even, least
irregular pattern and enter the number.



Print Head Alignment

Print head alignment s being executed. Referring to the
patterns printed in columns Ato K, select the pattern that
shows no flaws.

Adjust si 3~e7)
= commna:  [o_[7
H commng: ([0 [
é Column C:
= Column D:

Column E:
Adjust both wayh(-5~+5)
Column F :
Column G:
Column H:
Column 1:
Column J ;
Column K:
)
«C-anon 470D Printer Utility Version4.3
TestPrint =

B Nozzle Check
Prints a nozzle-check pattern.
)| PrintHead Atignment
It will align the print heads to correct any

rr
errorin their installation position.

Canoni4700 Version 43

6 Inthe same way, one by one, select the
most even patterns printed with the
least irregularities from each of
Columns B to K, enter their numbers
and click Send.

If it is difficult to pick the best pattern on Column H,
pick the setting that produces the least noticeable vertical
white stripes.

Less noticeable More noticeable
white stripes white stripes

7 Click Close.

8 Click OK.

This completes the printer setup. The printer is now
ready to use.

19



B Aligning the Print Head — Operation Panel

Index Al Gne__oeor Copies 1 Press the Maintenance button.

Photo Paper Photo Paper Plain Paper Borderless(M)/Date(®)
Pro Plus Glossy @I Vaintenance Photo Viewer

L0 O > 0.0

2 Press & three times to display 04 on
the LCD.

3 Press the Set button.

The pattern is printed.

4 Observe the printed patterns and check
the pattern in which vertical stripes are

— least noticeable.
V V If the patterns in column “H” are not uniform, select the
h—1 pattern in which white stripes are least noticeable.

e - P Less noticeable Move noticeable

e 7 white stripes white stripes

SE - BU [ VARS V4

g =

. - - -

i - -

index ‘Al Gne  DPOF_Copies Using e (cursor buttons), display

the pattern number (+7 to —-3) of the
checked patterns in column A.

Photo Paper Photo Paper Plain Paper Borderless(M)/Date(®)
Pro Plus Glossy Maintenance 'Photo Viewer

L OO O OO

20



Print Print Print
Ind_ex A_II O_ne DP_DF CO;.)\es

Photo Paper Photo Paper Plain Paper B ) D)
Pro Plus Glossy Maintenance Photo Viewer

L OO > 0O O

Print Print Print
Ind_ex A_II O_ne DP_OF CO;.)\es

Photo Paper Photo Paper Piain Paper B D3
Plus Glossy Maintenance ‘Photo Viewer

L OO > 0O O

Press the Set button.

The screen for selecting a pattern in column B (“b”)
appears.

= Note

To cancel an operation, press the Maintenance
button and retry the procedure from the beginning.

Repeat the above procedure to
determine the pattern numbers (+7 to —
3) of the checked patterns in columns B
through E and the pattern numbers (+5
to —5) of the checked patterns in
columns F through K.

When pattern numbers have been determined up to
column K, maintenance mode number “04” is displayed
again and head alignment is complete.

Press the Maintenance button.

You can exit the maintenance mode.

21



Basic Operations

+ Ifyou detect smoke, unusual smells or strange noises around the printer, immediately switch the
printer off and always unplug the printer. Contact your local Canon service representative.
* To avoid injury, never put your hand or fingers inside the printer while it is printing.

Printing with Windows

Adjusting the print settings according to your needs allows you to produce better quality prints.
In this section, we will use WordPad for the purpose of explanation. The procedures you use and the screens
that appear on your computer may differ according to the application that you use.

B Printing

I Document - Hotepad
FIEM Edit Format View Help

Hew Chrl+h
Open... Chrl+0
Save Chr+5

Save As...

Page Setup. ..

Exit

& print 2

Status Feady [ it to fle

G ] [

22

1 Print the document from the application.

On the File menu, click Print.
Check the application’s users manual for the actual
procedures.

Ensure your printer is selected, then
click:

* Windows XP —[Preferences]
* Windows Me/Windows 98 — [Properties]
* Windows 2000 —[Main] tab

Specify the required settings and click
OK

= Note

If you use anything other than plain paper, please
refer to “Basic Print Settings” on page 23.

To start printing, click OK.

Printing will start in a few moments.



B Basic Print Settings

For the best print quality, specify the minimum requirement settings in the Main tab. To get the best
results, ensure you select the type of media loaded in the printer when printing on paper other than plain

paper.
B printing Preferences (6)
&) Main |2 Page Setup| @) Stamp/Background | @# Effects| (3 Profiles| i Maintenance
Meda Type: ( Plain Paper v )— (1)
Papgr Source ‘Aulo Sheet Feeder v
Print Quality: O High h
@ Standard
& com — (@
O Custom )
Color Adjustrment ® Auto
(i o
= ,E;‘;’,E’;;:?g [ Grayscale Pining
[ Previews before printing (4)
ok [ cawd [[ Hel ri (5)
(1) Media Type Select the type of media loaded in the printer.

(2) Print Quality

Select one option from High, Standard and Draft. Select Custom to
set the print quality manually.

(3) Color Adjustment

If you wish to control the color adjustment settings in more detail,
select Manual.

(4) Preview before printing

Select this to check the layout before printing.

(5) Help

Click this for a more detailed explanation of the functions in the tab.
(This may not appear when using Windows XP or Windows 2000. If
this happens, click Start then select All Programs (or Programs) -
Canon i470D - Guide).

(6)?

Click this to change the cursor shape to ?. By clicking on the item’s
name with this ? cursor, an explanation will be displayed.

= Notes

* Clicking the Print Advisor allows you to change to the most appropriate print settings simply by
answering questions when prompted.

* Use the application to set the paper size and paper orientation. Before printing, open the settings
screen and check that the Page Size in the Page Setup tab is the same as that specified within

application.

* Refer to the User’s Guide for more information about printer driver functionality.
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Printing with Macintosh

Adjusting the print settings according to your needs allows you to produce better quality prints.

B Printing

@ Edit Font Size Style So 1 Open the Page Setup dialog box in
D= New =N E—— your application.

Open.. &0
|
g'a"vs: :‘S‘V On the File menu, click Page Setup. Check the
Save As.. application’s users manual for the actual procedures.
Page 5etup... .
Print.. %P
Print One Copy
Quit %0

Canoni470D

2 Specify the page setup.

For details, refer to “Page Setup” on page 25.

E: Edit _Font Size Style So 3 Open the Print dialog box in your

= e o — application to print the document.
E'a?: :‘: On the File menu, click Print. Check the application’s
Save As.. users manual for the actual procedures.
Page Setup...
Print One Copy ™
Quit 80

_—— gl s 4 Specify the print settings according to

your requirements.

For details, refer to “Basic Print Settings” on page 25.

[ Grayscale Printing

5 Click Print.

Printing will start in a few moments.
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B Page Setup

Use the Page Setup dialog box to specify the paper size settings.

Canon i470D

Version 4.3

Height:207.0mm  Width:210.0mm

%

PﬂDEI'SiZE‘ A4 % \'

[ Borderiess Frinting
Amount of Extension :
M. et Max.

scale:  [100 3] %

Orientation :

[ save Settings

B Basic Print Settings

Select paper size
you wish to use.

For the best print quality, specify the minimum requirement settings in the Print dialog box. To get the
best results, ensure you select the type of media loaded in the printer when printing on paper other than

plain paper.

Version 4.3

Print

Copies: El

Pages: @ All

Cancel

BJ Cartridge : Apply...

G From l:l To l:l Options...
<]

[Cotor

Media Type :

el Paper Source:
aa [Auto Feeder =)
Normal-size printing Print Mode:
(c )

[Pr1ain Paper =]

| | B0

[ Grayscale Printing

3

— (1)

— @)

(1) Media Type

Select the type of media loaded in the printer.

(2) Print Mode

Select the type of document you want to print.

To specify more detailed settings for the print quality or color, select
Manual and click Details.

(3) Print

Click this to start printing.

= Notes

See Balloon Help for more information about other printer driver functions.

Select Show Balloons in the Help menu for an explanation of each of the items in the setting
screen. To see the explanation, point to the item with the mouse.

Refer to the User’s Guide for more information about printer driver functionality.
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Print Head Maintenance

B If Blurring Occurs or If a Specific Color Does Not Print

Perform print head cleaning to improve the print quality. Ensure that the printer is turned on and follow
the instructions below.

* Windows
Open the printer driver settings screen and click the Maintenance tab. Click Cleaning.
See page 16 for details on how to open the setting screen.

* Macintosh
Open the Page Setup dialog box and click Utilities. Click Cleaning.

B When the Printer Runs out of Ink

Replace the empty ink tank with a new one.
Specify the following ink tanks when purchasing.

Ink Tank BCI-24 Color
Ink Tank BCI-24 Black

1 Open the front cover and remove the
empty ink tank.

Do not touch the lock lever.

color black lock lever

2 Install the new ink tank.

Close the front cover when finished.

= Note

When you enable the low ink warning, reset the ink
counter of the ink tank installed.

Refer to the User’s Guide for more detailed
procedures and information about maintenance.
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Appendix

Notes on Handling the USB Interface (for Windows Users)

If installation of the printer driver does not proceed as instructed in this Quick Start Guide, there may be a
problem with the USB driver installation.
Try reinstalling the printer driver.

B Reinstalling

If you cannot proceed beyond the Printer Port screen:

1 Click Cancel.

Follow this prosede.

When the Terminate Installation screen is
displayed, click OK.

Click Exit, then remove the CD-ROM.
Turn the printer off.
Restart the computer.

O AW N

Reinstall the printer driver (see page 8).

For Further Details...

For more information, place the Setup Software & User’s Guide CD-ROM in the CD-ROM drive.

B User’s Guide Contents

The “User’s Guide” is HTML manual you can browse through on your computer.

Contents

* Printer parts and their functions * Printing media

* Further printing techniques * Troubleshooting
* Routine maintenance » Specifications

B How to View the User’s Guide

For Windows For Mac OS 8.6-9.x
(1) Load the CD-ROM in your computer. (1) Load the CD-ROM in your computer.
(2) Click Documentation at left of the screen. (2) Double-click the Manual folder.
(3) Click View Documents. (3) Double-click the User's Guide folder.
(4) When a message appears, click (4) Select a language folder.
* Yes — to install the User’s Guide (5) Double-click the User’s Guide folder.
* No — only to browse the User’s Guide (6) Double-click the icon for the
(5) Select User’s Guide and click OK. i470D_UG_ENGhtm file.

Follow the instructions on screen.
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B Applications Included in the CD-ROM Package

= Note

For detailed description of the various features of photo applications and instructions on their use,
refer to the Photo Application Guide include on the Setup Software & User’s Guide CD-ROM.

Easy-PhotoPrint (Windows/Macintosh)

You can make a Borderless Printing easily and quickly, just by selecting a photograph taken with a digital
camera and the paper type on which to print. You can also use simple editing features such as trimming and
image rotation.

It is Exif Print (Exif 2.2) compatible.

Easy-WebPrint (Windows)

You can easily print homepages displayed on Internet Explorer or pages from User’s Guide (HTML manual
of this printer) in full size.

Easy-WebPrint automatically adjusts the layout when printing a screen.

This feature enables you to print a screen without its right end being cut.

This application is a plug-in for Internet Explorer, and its toolbar is automatically added to Internet Explorer
after installation.

Specifications

B Printer

Printing resolution:
4800* X 1200 dpi. max.

* Ink droplets can be placed with a pitch of 1/4800 inch at minimum.

Print speed (printing with Canon standard pattern):
Black printing
Draft: 18 ppm
Standard: 11.8 ppm
Color printing
Draft: 12 ppm
Standard: 4.9 ppm

Print width:
203.2 mm max. (8.0 in)
(for Borderless Printing: 216 mm/8.5 in)

Resident print control mode:
Canon extended mode

Receive buffer:
56 KB

Interface:
USB

Acoustic noise level:
Approx. 45 dB (A) (in the highest print quality mode)

28



Operating environment:
Temperature: 5 to 35°C (41 to 95°F)
Humidity: 10 to 90%RH (no condensation)

Storage environment:
Temperature: 0 to 40°C (32 to 104°F)
Humidity: 5 to 95% RH (no condensation)

Power supply:
AC 100-127 V, 50/60 Hz
AC 220-240 V, 50/60 Hz

Power consumption:
Standby: Approx. 3 W
Printing: Approx. 16 W

Dimensions
(without a paper rest and paper output tray retracted):
393 (W) X 258 (D) X 218 (H) mm
15.47 (W) X 10.16 (D) X 8.58 (H) in
Weight:
Approx. 4.0 kg (8.82 1b.)
Graphic image printing:
Data format:
Canon extended mode: Raster image format
Resolution:
Canon extended mode: 300, 600, 1200, 4800 dpi

Print Head:
Black: 320 nozzles (600 dpi)
Cyan, Magenta, Yellow: 256 nozzles per each color (600 dpi)
Ink Tanks:
Capacity (pages): .
Black (BCI-24 Black) approx. 300, approx. 580 2
Color (BCI-24 Color) approx. 160
*1 1500 characters per page, normal text, at standard and plain paper mode with Windows XP
printer driver
*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and plain paper mode with
Windows XP printer driver
Supported recording media:
CompactFlash Card, SmartMedia Card, SD Card, MultiMedia Card, Microdrive.

Supported recording formats:
JPEG (DCF/CIFF/Exif 2.2 or earliet/JFIF), TIFF (Exif compliant), DPOF compliant

B Camera Direct Print

Interface:
Camera Port
(Connect a Canon “Bubble Jet Direct” compatible digital camera or digital video camcoder using the
USB cable supplied with it.)

Compatible digital cameras and digital video camcorders:
Canon “Bubble Jet Direct” compatible digital cameras and digital video camcorders
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Compatible Paper:
Card #1 (Photo Paper Pro 4” X 67/101.6 X 152.4 mm), Card #2 (Photo Paper Plus Glossy 4” X 6"/
101.6 X 152.4 mm), Card #3 (Photo Paper Plus Glossy 5” X 7°/127.0 X 177.8 mm), LTR (Photo
Paper Pro or Photo Paper Plus Glossy Letter), A4 (Photo Paper Pro or Photo Paper Plus Glossy A4)

Layout Print:
Standard: Borderless / with border, Index Print: 15-80 images

Print Quality:
1 level

Effect:
Exif Print Compatible

DPOF Functions:
Ver. 1.00 compatible (Index print, number of copies, select images, print special characters (date/
image no.))

BJ Printer Driver Systems Requirements

For Windows

 Use a computer equipped on which Windows XP, Windows 2000, Windows Me, or Windows 98 can
operate.

+ USB* interface

* Available hard-disk space for printer driver installation

Windows XP/Windows 2000: 60MB
Windows Me/Windows 98:  25MB

* USB operation can only be guaranteed on a PC with pre-installed Windows XP, Windows 2000,
Windows Me, or Windows 98. (This includes Windows XP, Windows 2000, or Windows Me
upgraded from pre-installed Windows 98 or later)

For Macintosh

+ Use a Macintosh series computer equipped with USB interface on which Mac OS 8.6-9.x or Mac OS
X v.10.2.1 or later can operate.

* Available hard-disk space for printer driver installation

Mac OS 8.6-9.x: 40 MB
Mac OS X v.10.2.1 or later: 110 MB
* The following functions are not supported when using Mac OS X v.10.2.1 or later:
- Duplex Printing
- Photo Optimizer Pro

Additional Systems Requirements for User’s Guide

+ Pentium® 75 MHz equivalent or higher processor (Pentium® 133MHz equivalent or higher processor
recommended)

¢ 2x or higher CD-ROM drive (4x or higher recommended)

* 10 MB of available hard-disk space (when installing the User’s Guide)

* Microsoft Internet Explorer 5.0 or later
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